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Book Descriptions:

C20 manual tandberg

Use the remote control to operate your TANDBERG video system. A few. 11 Oct 2010. TelePresence
System Quick Set C20 Access product specifications. 1 MB; TANDBERG Codec C Series User Guide
TC3.0 PDF 4 MB. 1 Feb 2011. This document provides information required to administrate the
Codec C20 based video systems at an advanced level. Profile 42”. Administrator guide for Profiles
using Codec C20 and Quick Set C20. Cisco TelePresence Quick Set C20. This document describes
how to install the Cisco TelePresence System Quick Set C20. Cisco C20 TelePresence System
Manual Online Codec C20 The Physical Interface. Formerly tandberg 7 pages. Conference System
Cisco Codec C90. Conference System Cisco. Cisco Tandberg TelePresence System Profile 42inch
includes Codec C20, NPP option, and PrecisionHD 1080p Camera.Cisco Tandberg Border Controller
User Manual Read more about xconfiguration, gatekeeper.Reload to refresh your session. Reload to
refresh your session. Following the launch of their telepresence technology and acquisition of
Norwegian video conferencing manufacturer TANDBERG, Cisco is now active in the. MITSUBISHI
DAC20. Tandberg 3004 Rendez vos souvenirs durables !. Russian mythology and Horn loudspeakers.
Cisco Tandberg Border Controller User Manual Read more about xconfiguration, gatekeeper. Note
Dual display option is needed for C20 and C40 to output to a second screen. Prior to TC3 C40 DVI
output needed option key see TC4 Release notes. German, Simplified Chinese, Korean, Japanese,
Russian, and Traditional. Chinese. When you install. Tandberg C20 systems, none of you can receive
people. DPI Universal 7 C13 PDU with 2 m IEC 320C19 to C20 rack power cord, 00YE443. Tandberg
E20 VoIP Video Phone Attractive Scandinavian design, Superior quality IP telephone with advanced.
Korean, Norwegian, Portuguese, Russian, Spanish, Swedish. Dimensions Codec C20, 13.7 x 12.4 x
6.9 H x W x D. 7 Dec 2016. Japanese, Russian, Korean, Czech, Magyar, Polish, Finnish,
Thai.http://janaturismointegrato.com/uploads/delonghi-espresso-machine-user-manual.xml
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Upgrade CISCO C20 to latest version. Reload to refresh your session. Reload to refresh your session.
Getting started Making calls Using the phone book Incall features Advanced settings TANDBERG
QUICK SET C20 GETTING STARTED D14503.01 USER GUIDE TANDBERG QUICK SET C20—July
2009. Your TANDBERG Quick Set C20 is operated by means of the remote control. All you need to
know to get started are a few basic navigation The little triangle principles. Note that this feature
may be utilized any time. D14503.01 USER GUIDE TANDBERG QUICK SET C20—July 2009. Give it a
descriptive name, use special characters, if needed. Moving and zooming the camera Use the keys
Save the new preset. ARROW and the keys. ZOOM D14503.01 USER GUIDE TANDBERG QUICK
SET C20—July 2009. The face recognition system aims to search for faces in order to optimize the
picture frame, and is therefore called BestView. Once a face or group of faces has been detected
camera zoom and camera angle will be changed accordingly to obtain an optimal representation on
the screen. Use Automatic if that is more convenient. D14503.01 USER GUIDE TANDBERG QUICK
SET C20—July 2009. This feature is also available as a softbutton when you select Camera control.
D14503.01 USER GUIDE TANDBERG QUICK SET C20—July 2009. For privacy you may set the
microphone to be muted upon autoanswer. You will then have to activate the microphone yourself
press D14503.01 USER GUIDE TANDBERG QUICK SET C20—July 2009. ARROW D14503.01 USER
GUIDE TANDBERG QUICK SET C20—July 2009. ARROW page. keys and the key in the usual manner
to set everything as ARROW required. D14503.01 USER GUIDE TANDBERG QUICK SET C20—July



2009. ARROW D14503.01 USER GUIDE TANDBERG QUICK SET C20—July 2009. ARROW
D14503.01 USER GUIDE TANDBERG QUICK SET C20—July 2009. Make sure the system displays
the Home menu press the key on the remote control to display this menu. Then press the rightmost
softbutton to display the System information.
D14503.http://promtong.com/promtong/temp/delonghi-magnifica-3300-espresso-machine-manual-pdf
.xml

01 USER GUIDE TANDBERG QUICK SET C20—July 2009. Getting started Making calls Using the
phone book Incall features Advanced settings TANDBERG QUICK SET C20 MAKING CALLS
D14503.01 USER GUIDE TANDBERG QUICK SET C20—July 2009. Press the key on Press followed
by or, press twice to start calling.Alternatively, you may This is described in the section Phone book
usage.This is described in the section Using the Phone book. D14503.01 USER GUIDE TANDBERG
QUICK SET C20—July 2009. Use the rightmost to clear the call history. D14503.01 USER GUIDE
TANDBERG QUICK SET C20—July 2009. Getting started Making calls Using the phone book Incall
features Advanced settings TANDBERG QUICK SET C20 USING THE PHONE BOOK D14503.01
USER GUIDE TANDBERG QUICK SET C20—July 2009. It contains a section in which you can add
your own list of contacts, and most corporate solutions will also include a corporate phone list. How
to open the phone book is described Basic phone book features, which can be found two pages back.
D14503.01 USER GUIDE TANDBERG QUICK SET C20—July 2009. Edit as required and navigate
down to Save and press the key to put the changes into effect. D14503.01 USER GUIDE TANDBERG
QUICK SET C20—July 2009. Getting started Making calls Using the phone book Incall features
Advanced settings TANDBERG QUICK SET C20 INCALL FEATURES D14503.01 USER GUIDE
TANDBERG QUICK SET C20—July 2009. Getting started Making calls Using the phone book Incall
features Advanced settings TANDBERG QUICK SET C20 ADVANCED SETTINGS D14503.01 USER
GUIDE TANDBERG QUICK SET C20—July 2009. This is normally The IP settings not shown are also
aimed at system administrators. Expand the Camera preset menu. Use the keys to go between the
presets existing. VERTICAL ARROW D14503.01 USER GUIDE TANDBERG QUICK SET C20—July
2009. Expand the Speed dials menu. D14503.01 USER GUIDE TANDBERG QUICK SET C20—July
2009. In this chapter.

Your TANDBERG Codec C20 has been Explains the menu system designed to give you many years of
safe, reliable operation.Digital User Guides TANDBERG is pleased to announce that we have Waste
Handling replaced the printed versions of our user guides In order to avoid the dissemination of
hazardous with digital versions available on the TANDBERG. CAUTION! In order to be able to use
the system for video calls, all orange colored sockets must be connected. The illustration below
shows the rear panel of the TANDBERG Codec C20. INITIATE CALL Select a name from the Phone
book or enter the Use the keypad in the same way as you would name, number or URI and press the
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Call key to initiate the call. Explains the menu system. Home menu Call Menu for making calls.
Settings menu Presentation Select a presentation source. Explains the menu system. The Standby
settings Go to This is the default factory setting.The default password is “public”.TMS is short for
TANDBERG Management System. Please contact your Enter a name for the external phonebook.On
Set up multiple outbound connections to servers in the Proxy Address list. Enter the name of the
video input source 1, which for Codec C20 generally will be the main camera. On Let the system
automatically adjust aspect ratio. NOTE! The Experimental menu WILL change. We recommend you
visit the TANDBERG web site regularly for updated versions of the manual. Go to D14489.01—JULY
2009. The HDMI cable The HDMI cable delivered with the camera is 5 meters. The TANDBERG
Quick Set C20plus is delivered with a Auto PrecisionHD 1080p 12x zoom with 1080p60 maximum
resolution. Explains the menu system. The TANDBERG Codec C20 often produces excellent results
together with the TANDBERG PrecisionHD 1080p camera has the Avoid harsh side lighting or strong
light from above. Natural communication Making eye contact Making eye contact with the far end
participants. Optional, you can connect two microphones.

http://superbia.lgbt/flotaganis/1647766485

See the General room guidelines section for how to position the microphones. Place the microphone
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nearby the meeting participants. Contact your TANDBERG representative if you have Login to the
codec forgotten the password. How to change the menu password You can login to the codec with
the user name and password, either from a web interface or from a command line interface. The
Wallpaper page The web interface allows for remote administration of the system. The Call page The
web interface allows for remote administration of the system. The release key Contact your
TANDBERG representative to obtain the release key. D14489.01—JULY 2009. EC Declaration of
conformity MANUFACTURER TANDBERG Telecom AS PRODUCT NAME TANDBERG Codec C20.
The TANDBERG Profile, the Profile 52” User Guide Quick Set C20 and Quick Set C20 Plus, as well as
solutions based on the Codec C Series, Profile Series, Codec C Series bring colleagues facetoface at
the touch of a bGetting started Making calls Using the phone book Incall features Advanced settings
What’s in this guide. What’s in this user guide. Making calls using the recent calls list. 24 Getting
started The icons used. 24 Waking up the system. 4 Management systems booking list. 25 The TRC5
remote control. 5 Calling more than one optional.Getting started Making calls Using the phone book
Incall features Advanced settings Getting started After wakeup, the screen will typically look like
this Waking up the system The dialin address H.323 Alias ID or dialin To make a call you need to
wake up the system from standby. number H.323 Alias E164 of your system is However, if someone
calls you, the system will wake up by itself. Date and time of day.Getting started Making calls Using
the phone book Incall features Advanced settings Getting started The TRC5 remote control The
function keys in the upper part of the remote control reflects the softkeys on screen.

http://www.decor-ada.com/images/brady-labpal-printer-manual.pdf

The middle part of the remote control is used to handle video, sound, phone book, menus and
navigation. The lower part of the remote control is similar to the keypad of a mobile phone.
FUNCTION KEYS Each key corresponds to a soft key on the screen and repGetting started Making
calls Using the phone book Incall features Advanced settings Getting started Alphanumeric keypad
Use the keypad in the same way as you would use a mobile phone. PHONE BOOK Press the LAYOUT
Press the key to display the key to display the Layout phone book.Getting started Making calls Using
the phone book Incall features Advanced settings Getting started Example showing a submenu

http://www.decor-ada.com/images/brady-labpal-printer-manual.pdf


displayed by pressing the right arrow key. Navigating in the menus Use the remote control to
operate your TANDBERG video system. A few basic navigation principles are all you need to know to
get started.Use the arrow key Getting started Making calls Using the phone book Incall features
Advanced settings Getting started Entering text in text fields Using the number keys in text fields
Whenever text entries are expected by the system, a small abc appears in the right lower Some
menu fields expect text information to be entered. This is used to corner of the entry field.It is also
For entry fields expecting numbers, 123 wilGetting started Making calls Using the phone book Incall
features Advanced settings Getting started Screen layout Layout control outside a call is limited to
the choice between showing The layout of the screen can be changed as shown to the right.To show
the display options screen, press the outyla key.Getting started Making calls Using the phone book
Incall features Advanced settings Getting started Camera presets Using the presets I You may create
predefined settings of where the camera points and the zoom. This is referred to as camera presets.
See the next page for more. Do as follows 1. Press the key on the remote control to display the
Layout menu. Select Selfview to be shown as required.

http://demenagementlandry.com/images/brady-labxpert-manual.pdf

In this way you will see what other will see of you in a call. CamerGetting started Making calls Using
the phone book Incall features Advanced settings Getting started Adding a camera preset Adding a
camera preset For more on camera presets, as such, see the previous page. To add a camera preset,
do as follows In the Camera presets menu 1. Press the key on the remote control to display the
Layout menu.Select Selfview to be shown. In this way you will see what other will see of you in a
calGetting started Making calls Using the phone book Incall features Advanced settings Getting
started Camera settings Adjusting the exposure Camera settings let you adjust the exposure and
whitebalance. If you change the Select Selfview to be shown as required. Brightness mode to
Manual, the Brightness 2. Press the key on the remote control to display the Home menu and level
will be possGetting started Making calls Using the phone book Incall features Advanced settings
Getting started Main source Call settings—an overview You may choose what to use as the main
input source. This will typically Use the Call settings menu to set the default bit rate and how the
system be the camera, a secondary camera if applicable, the PC input or other shall answer
incoming calls. Answering can be set to automatic or to sources such as a DVD player. manual. More
on thGetting started Making calls Using the phone book Incall features Advanced settings Getting
started Call settings—auto answer options Call settings—default call rate You may set up your
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system to answer automatically whenever someone The Call settings menu lets you set the default
call rate expressed as calls you. If you choose to do so, you may also specify how long time it default
number of kilobits per second.

You may want Getting started Making calls Using the phone book Incall features Advanced settings
Getting started Language settings About the setting of date and time This will allow you to specify
the language used in the menus and settings You may have the system pick date and time for you or
you may specify shown. The following languages are supported English, Norwegian, date and time
zone settings along with date and time format and the date Swedish, German, French, Italian,
JapaGetting started Making calls Using the phone book Incall features Advanced settings Getting
started Setting date and time manually Setting date and time automatically You may specify date
and time zone settings along with date and time You may have the date and time of day set
automatically. However, you format and the date and time of day itself.Do as follows Do as follows 1.
Start from the Home menu Getting started Making calls Using the phone book Incall features
Advanced settings Getting started Selecting ring tone Setting ring tone volume The system lets you
choose between many ring tones. The system lets you set the ring tone volume. Do as follows Do as
follows 1. Start from the Home menu and navigate down to Settings and press 1. Start from the
Home menu and navigate down to Settings and press the key. the key. 2. Then navigate to Sounds
and alerts and preGetting started Making calls Using the phone book Incall features Advanced
settings Getting started Setting key tone to on or off Setting wallpaper on your screen The system
may be set to emit a sound every time you click key on the The system lets you set a wall paper on
your screen. This is shown in idle remote control.Getting started Making calls Using the phone book
Incall features Advanced settings Getting started Inserting your own wallpaper System information
The system lets you upload and use your own wallpaper for example your System information can be
listed.

http://baharemadinah.com/wp-content/plugins/formcraft/file-upload/server/content/files/1626e8dd88
37d7---bosch-instantaneous-hot-water-system-manual.pdf

This custom wallpaper picture can be any size up to Do as follows 19201200 pixels. 1. Start from the
Home menu and navigate down to Settings and press the The custom wallpaper is uploaded from
thGetting started Making calls Using the phone book Incall features Advanced settings Getting
started Entering the Advanced configuration Restarting the system Your video system has a separate
set of Advanced configuration settings Some changes in the system settings, network settings and
the intended to be used by system administrators only. These settings are infrastructure
configurations may call for a system restart.Do as follows Do as foll. And by having access to our
ebooks online or by storing it on your computer, you have convenient answers with C20 Tandberg
User Guide. To get started finding C20 Tandberg User Guide, you are right to find our website which
has a comprehensive collection of manuals listed. Our library is the biggest of these that have
literally hundreds of thousands of different products represented. I get my most wanted eBook Many
thanks If there is a survey it only takes 5 minutes, try any survey which works for you. And by having
access to our ebooks online or by storing it on your computer, you have convenient answers with
Tandberg Administrator Guide. To get started finding Tandberg Administrator Guide, you are right
to find our website which has a comprehensive collection of manuals listed. Page Count 39 Entering
text in text fields What happens when you press a number key.Getting star ted Making c alls Using
the phone book In c all f eatures Advance d settings Wha t ’s in thi s gu id e 2 D145 0 3.01 U SER G
UI DE TA ND BE RG Q UI CK S E T C2 0 — Ju ly 20 0 9 What ’ s in thi s use r guid e.Getting star ted
Making c alls Using the phone book In c all f eatures Advance d settings Ge t tin g st ar te d 3 D145
0 3.

AYHANCEVIK.COM/images_upload/files/93-honda-civic-manual-transmission-fluid.pdf
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01 U SER G UI DE TA ND BE RG Q UI CK S E T C2 0 — Ju ly 20 0 9 T A NDBE R G QU ICK SE T C20
G E T TI NG ST ARTE D Getting star ted Making c alls Using the phone book In c all f eatures
Advance d settings Ge t tin g st ar te d 4 D145 0 3.01 U SER G UI DE TA ND BE RG Q UI CK S E T
C2 0 — Ju ly 20 0 9 After wak e up, the screen wil l t ypic ally look lik e this W ak ing up the sys tem
T o mak e a c all you need t o wake up the sy stem from standby.The IP number or your URI is the
dial in number of your s ystem and will appear here. Date and time of day. Sof tbuttons described on
the follo wing pages. Getting star ted Making c alls Using the phone book In c all f eatures Advance
d settings Ge t tin g st ar te d 5 D145 0 3.01 U SER G UI DE TA ND BE RG Q UI CK S E T C2 0 — Ju
ly 20 0 9 The TRC 5 remote con trol The fu nct ion keys in the upper par t of the r emote control r ee
cts the softbut tons on screen.... and the middle par t of the remo te control is used to handle the
video par t of the call.. while the lower part of the remot e control resembles ve r y much the keypad
of a cell phone. FUN CT ION K EYS Each key r eec ts a softbut ton on screen and repres ents shor
tcuts and advanced functions. Getting star ted Making c alls Using the phone book In c all f eatures
Advance d settings Ge t tin g st ar te d 6 D145 0 3.01 U SER G UI DE TA ND BE RG Q UI CK S E T
C2 0 — Ju ly 20 0 9 CALL P ress the k ey to display the r ecent c a lls menu. Select one or more
contacts and press the k ey to in itiate the call. Al pha num er ic keyp ad Use the ke yp ad in the
same way as you wou ld use a cell phone. HOM E Press the k ey to go back to the Home menu.
PHON E BOOK Press the k ey to display the phone book. L A Y OUT Press the k ey to display the L
ayout men u, then select a view in the menu. Getting star ted Making c alls Using the phone book In
c all f eatures Advance d settings Ge t tin g st ar te d 7 D145 0 3.

01 U SER G UI DE TA ND BE RG Q UI CK S E T C2 0 — Ju ly 20 0 9 Navigating in the menu s Y our T
A N DBERG Quick Set C 20 is operated by means of the r emote control. Press the key t o produce
the ho me menu on the screen. The element currently select ed is indicated by an orange rectangle.
Use the vertical ar row k eys to navigate up and down in a menu. The lit tle triangle indicates that a
submenu is available. Exam ple showing a submenu pr oduc ed by pressi ng the right ar row k ey.
The lit tle triangle indicates that there ar e fur ther submenus avai lable. Use the right arrow k ey or
to sho w this submenu. Conte x t sensitive softke ys cor responding to the fu nction keys of the remo
te control. Softkeys no t used in a given cont ext are shown ghosted. If th ere is no menu sho wn..
Wak e up the system by l if ting the remo te control and pr ess the k ey to produce the Hom e menu.
Use the lef t arrow key t o collapse the menu expansion, i.e. t o go back one level. Use the hom e k
ey to e xit all menus and re turn to showing the Hom e menu only. Getting star ted Making c alls
Using the phone book In c all f eatures Advance d settings Ge t tin g st ar te d 8 D145 0 3.01 U SER
G UI DE TA ND BE RG Q UI CK S E T C2 0 — Ju ly 20 0 9 Entering te x t in tex t e ld s Some menu
elds expec t te xt information to be ent ered. Ap art from the need to en ter the number or identity of
the person you want t o c all, y ou will also — among other things— need this ability to search and
main tain your list o f contac ts in the phone book. Usin g t he n umber k eys in text el ds Whenever
te xt entries are e xp ected by the syst em, a small ab c or ABC appears in the right lower corner of
the en tr y eld. For entr y elds expecting numbers, 123 will appear instead. In te x t mode, entries fr
om the number k eys are aut omatically interpret ed as te x t entries in the same way as on a cell
phone. Special characters Sometimes you will need t o make use of special characters, e.g.

when ent ering names in My c ont ac t s. Whenever it is lik ely th at special characters are needed,
the softbut ton speci al cha rac ters g iving you access to the special characters menu will be
displayed. Sp ec ia l c ha rac te r s Getting star ted Making c alls Using the phone book In c all f
eatures Advance d settings Ge t tin g st ar te d 9 D145 0 3.01 U SER G UI DE TA ND BE RG Q UI CK
S E T C2 0 — Ju ly 20 0 9 Sc ree n la yout The layout of the screen can be changed as shown to the
right. T o produce display options screen, press the la yout key. L ay out c ontr ol used during a c all
gives y ou the possibilit y to include selfv iew.. Addi ng w allpaper t o yo ur screen In the Se t tin gs
submenu navigate down to Wal lpa per. Press again. In the Hom e menu, navigate down to Set ti ng
s and press the key. Select b etween the options available and press the key t o leave the menu



putting your choice into e f fect. See also page 1 9 for more on this. Howev er, if you already have
activated the selfview, the menu will give you thes e options when you ent er the menu again. Howev
er, if you already have activated the selfview, you may select where the selfview should appear in the
image w hen you ent er the menu again. L ay out c ontr ol outside a call is limited t o the choice
between showing self view and showing a wallpaper. L ay out c ontr ol when in a call provides the
choice of showing selfview or full screen par ticipant.. Getting star ted Making c alls Using the
phone book In c all f eatures Advance d settings Ge t tin g st ar te d 10 D145 0 3.01 U SER G UI DE
TA ND BE RG Q UI CK S E T C2 0 — Ju ly 20 0 9 Came ra pres e ts Y ou may create pr edene d
camera zoom and angle sets se the ne xt p age for details . This is r eferred t o as camera presets. Do
as f oll ows 1. Press the k ey on the remot e control to display the Layout menu. Select S el f vi ew to
be shown as requir ed. In this way you will see what other will see o f you in a call. 2.

P ress the key on the r emote cont rol to display the Home menu and select Ca me ra co nt rol. 3. T
his will cause softbut tons t o app ear. Press the f un cti on ke y corresponding to Cam er a pre se t s
f un ct ion key number 2 fr om the left. Where to nd it Usin g t he pr esets Use the vertical arrow ke
ys to navigate i n the menu and use to select a pres et causing the camera to move accordingly. N ot
e that this f eature may be utili zed any time. Getting star ted Making c alls Using the phone book In
c all f eatures Advance d settings Ge t tin g st ar te d 1 1 D145 0 3.01 U SER G UI DE TA ND BE RG
Q UI CK S E T C2 0 — Ju ly 20 0 9 Adding a c amera p res et For more on camera presets as such,
see the pr evious page. T o ad d a ca me ra pre s et, d o as f oll ows 1. In this way you will see what
other will see o f you in a call. 2. A djust camera position and zoom using the four a rrow key s and
the zoom key. 3. P ress the key on the r emote cont rol to display the Home menu and select Ca me
ra co nt rol. 4. T his will cause softbut tons t o app ear. Press the f un cti on ke y corresponding to
Cam er a pre se t s fun cti on key n umber 2 from the left. 5. Follow the pr oc edure sho wn to the
right. Addi ng a camer a pr eset Mo vin g an d z oomi ng the camera In the Cam er a pre se t s menu
navigate t o Add ca me ra pr es et and press. Navigate to the pr eset to dene or redene, if it already
exist ed. Press t o produce the submenu. Give it a descriptive name, use special charac ters, if
needed. Save the new pr eset. Use the arrow keys and the zoom key s. Getting star ted Making c alls
Using the phone book In c all f eatures Advance d settings Ge t tin g st ar te d 12 D145 0 3.01 U SER
G UI DE TA ND BE RG Q UI CK S E T C2 0 — Ju ly 20 0 9 Be stView — Face re cogni tion The T A
ND BERG Prole is capable of doing face recognition. The face recognition system aims t o search for
faces in order t o optimiz e the picture frame, and is theref ore called Be s tVie w.

Once a face or group of faces has been det ec ted camera zoom and camera angle will be changed
acc ordingly to obtain an optimal r epresentation on the scr een. Usin g B es t view 1. P ress the key
on the r emote contr ol to display the Layou t menu. Select S el f vi ew to be shown as requir ed. 2.
Press the key on the r emote contr ol to display the Hom e menu and select Ca me ra co nt rol 3. T
his will cause softbut tons t o appe ar. Press the f unc ti on ke y corresponding to Cam er a pre se t s
and navigate t o Be s t vi ew. 4. P ress on the remot e control to start the B es t vi ew optimization
process. Look towards the camera for about ve seconds 5. T he system wil l now look for faces and
adjust the zoom and camera angle to obtain a best t. Where to nd it The sof tbuttons shown are pr
odu ced via the Ca me ra co nt rol menu. Use this softbut ton to exit. Getting star ted Making c alls
Using the phone book In c all f eatures Advance d settings Ge t tin g st ar te d 13 D145 0 3.01 U SER
G UI DE TA ND BE RG Q UI CK S E T C2 0 — Ju ly 20 0 9 C am er a sett i n gs Camera set tings let y
ou adjust the exposure and whit ebalance. Press the f unc ti on ke y corresponding to Cam er a se t
tin gs f unc tio n k ey number 2 from the left. 4. Follow the procedures outlined to t he right. Adj
usting the exposu re Adj usting the whiteb alance If you change the Bri ght ne s s mod e to Manu al,
the Bri ght ne s s level w ill be possible to set by you. Since Auto has been chosen here, the actual
level i s shown ghosted. Backlight compensates for an y back light shining on th e c amera from
behind y ou causing you to appear dark. Since the whitebalance has been set to Manua l in this case,
you will have access to se t ting the whit ebal ance in the usual manner. Use Auto mat ic if that is



more conv enient. Getting star ted Making c alls Using the phone book In c all f eatures Advance d
settings Ge t tin g st ar te d 1 4 D145 0 3.

01 U SER G UI DE TA ND BE RG Q UI CK S E T C2 0 — Ju ly 20 0 9 Main sou rc e Y ou may choose
whether to use the camera or the PC input as your main source. Star ting from the Home menu,
navigate down to Set t ing s and press the k ey. Then navigate to Main s ou rc e and press the key.
Select bet ween the options shown in the Fig. below. Pre ss the key t o exit the men u put ting
changes into e f fect or the lef t ar row k ey to leav e the menu going one step back. Fur ther details
ar e shown on the ne x t page. This featur e is also available as a softbut ton when you se lec t Cam
era co nt rol. Call s et tings — an o ver view The C all s e t ting s menu lets you se t the default bit
rat e and whether and how the syst em shall answer i nco ming calls aut omatic ally. T he options ar
e treat ed more in detail on the ne x t page. Then navigate to Call s e t ting s and press the k ey.
Selec t between the options shown in the Fig. below. Pre ss the key t o exit the men u put ting
changes into e f fect or the lef t ar row k ey to leav e the menu going one step back. Fur ther details
ar e shown on the ne x t page. Getting star ted Making c alls Using the phone book In c all f eatures
Advance d settings Ge t tin g st ar te d 15 D145 0 3.01 U SER G UI DE TA ND BE RG Q UI CK S E T
C2 0 — Ju ly 20 0 9 Call s et tings — auto answer o ptions Y ou may set up your syst em to ans wer
automatically whenever someone calls you. If you choose to do so, y ou may also specif y how long
time it shall tak e before y our system connects you and whether y our microphone should be muted
turned off or not. Call s et tings — de faul t call ra te The C all s e t ting s menu lets you se t the
default call rate e xpressed as default n umb er of kilobits per second. Y ou may want to consult y
our system admi nistrator t o discuss the best setting in your envir onment.
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